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Introduction 
 
As soon as FSC Manager is installed, the agency should complete the System setup.  This mainly 
involves entering the agency name, producers, companies and default commission percentages.  Having 
this information setup before users begin using the system will ensure that all areas of FSC Manager are 
properly functioning together. 
 
This chapter will explain how to add to or modify the list of sub-Agencies, producers, companies and 
commission Rates.  It will also explain the other system defaults and provide instruction on how to setup 
scanned signatures for use on ACORD applications and forms. 

System Information 
 

To access the System Information click the System button on the Banner.  Notice the toolbar at the top of 
the System area. 

 

 

Figure 1:  Toolbar 

 

The first four buttons are Navigator buttons.  They allow users to move between records: go to the first 
record, go back one record, go forward one record and go the last record.   

The plus button is used to add new records.  If an area is blank, it is not necessary to click the plus 
button, simply type in the record.  All data is saved automatically when the System area is closed.   

The up arrow is used when the user wants to edit a record.  The checkmark will post (save) the edit.  The 
x will cancel the edit. 

The rounded arrow button will refresh the data. 

The grid button will open the grid view for the tab you are viewing. 

Sub-Agencies, Producers and Companies can not be deleted; however, they can be made Inactive in the 
Status field. At the top of each tab is a Display filter.  This filter defaults to displaying only Active records.  
The user may view the Inactive records by changing the Display filter to Inactive or Both. 

 

 

Figure 2: Display Filter 

 

The Search field on each of these tabs is used to find a producer or company in the system by typing 
their name. 

Sub-Agencies 
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This tab contains the agency information: name, address, phone numbers and email address.  This 
integrates with various parts of the system such as ACORD applications, forms, letters and memos.  If an 
agency has multiple locations, additional sub-agencies may be added.  This allows reports to differentiate 
data between sub-agencies.  

Each client is assigned to a sub-agency by the user when the client is first added to the system.  All users 
will be able to see all clients regardless of sub-agency. 

To add the first agency, simply begin entering the agency information.  To add additional sub-agencies 
use the plus button.  When multiple sub-agencies exist, go to the System Defaults tab and delete the 
agency name from the Default Sub-Agency field.  If this is not removed, all new clients will continue to be 
assigned to the default agency.  When this field is blank, the system will prompt the user to assign each 
new client to a sub-agency.  All new information will save automatically when the System area is closed. 

 

 

Figure 3: Sub-Agencies 

Producers 

This tab stores producer information.  Producers can be assigned to clients/policies for purposes of 
reports, marketing and tracking commissions.  Enter the producer’s first, middle and last name and hit  
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tab.  A three letter code will be assigned to the producer automatically.  Many of the fields are optional: 
Street Address, Mailing Address, City, State, Phone, FAX, License Number, Expiration, Sub-Agency, 
Social Security and National Number.  These optional fields do not integrate with any other area of the 
system. 

The following fields must be completed: Producer Type, Base, Default Commission %.  These areas 
integrate with the commission tracking for producers.  Even if a producer is not paid on commission, it is 
best to enter a Base of Commission Based with Default Commission % of zero.   

Producer Type – Most producers are Agents. 

Base - Commission Based means the producer will be give a percentage of the agencies 
commission.  Premium Based means the producer will be given a percentage of the entire premium. 
Most producers are Commission Based.   

Default Commission % - New % is the commission percentage give on new policies.  Renewal % is 
the commission on renewed policies.  Days New is the number of days the agency will consider a 
policy new and pay the producer the New %.  If most policies written by the producer are an annual 
term length, then enter 365.  If the producer receives the same percentage for new and renewal, the 
Days New could be left at 0. 

Use the plus button to add additional producers.  Each time a producer is added, the following message 
will appear when the user changes tabs or exits the System area. 

 

 

Figure 4: Inserted General Ledger Number 

Companies 

This tab stores Company information.  This area integrates with ACORD applications, forms, letters and 
memos and emails.   

Enter the company name and hit tab.  A three letter code will be assigned to the company automatically.  
Continue to enter the Address, Phone Number and Email Address.  The Agency ID is the agency’s 
contract number or producer code with the company. 

If a company will be downloading policies to the system, the Plans will be set up by the trainer or 
customer service representative when the download setup is done.  If the carrier does not download, then 
the agency may enter the plans themselves.  Plans are the carrier specific tiers such as Standard, 
Preferred, and Elite.  Each company will have different names for their plans and some companies may 
not have plans. 

Each carrier should only be entered once in the System area.  If there are multiple addresses, enter these 
in the Address Book on the Banner.  If there are multiple contacts at the carrier, these can be listed in the 
Contact Information with email address and phone numbers.  This area integrates with email. 
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On the Companies tab the user will also be able to add Contacts, Notes and create Tranlogs, Followups, 
Emails and Memos.  The user will also be able to attach documents and images to the company record.  
Please see the chapters on these areas to learn how each works. 

 

 

Figure 5: Companies 

General Agencies 

The General Agencies tab will be used to enter General Agencies on the policy screen when a piece of 
business is being brokered through a general agency.  For each general agency that is added, a new 
general ledger account will be assigned to the chart of accounts.  When a policy is assigned a general 
agency, any agency billing that is done, will create a payable amount to the general agency rather than to 
the carrier. 

The user will fill out the General Agencies tab using the same directions as above for the Companies tab.  
The user will also be able to add Contacts, Notes create Tranlogs, Follow ups, Emails and Memos and 
attach Images for the general agency.  Please see the chapter on each of these areas to learn how they 
work. 
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Figure 6: General Agencies 

Percentages 

This tab stores the agency’s default commission percentages and the producer commission splits with 
each carrier. Even if a carrier is downloading commission statements, this should be filled out.  Several of 
the reports in the system calculate annualized commissions and will utilize these defaults percentages for 
that purpose.  We recommend using the Auto Fill feature.  This will mass load a commission percentage 
for all policy types.  Even if the agency does not write that line of business, it will not harm the system to 
have a percentage.  Our experience has been that agencies frequently miss lines of business if they do 
not use the Auto Fill feature.   

There are two scenarios that can not be handled in the Percentages defaults.  They have to be handled 
on a per policy basis:  Workers compensation policies that give a different commission percentage based 
on the premium amount and youthful drivers because the commission is different on only one vehicle not 
the entire policy. 

Once commission percentages are entered here, they will populate into the Billing Setup area of the 
system.  If the commissions need to be changed here, they will also have to be changed on each policy in 
Billing Setup. 
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Agency Commissions 

1. Search for the company. 

2. In the three blanks to the right of the Auto Fill button, enter the most common rate the agency 
receives for new business, renewals and endorsements. 

3. Click the Auto Fill button. 

 

Figure 7: Percentages 

 

4. This will display a list of all policy types in FSC Manager.  Click the Select All button to highlight the 
records and click OK. 
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Figure 8: Auto Fill Policy Types 

 

5. This will pre-fill all policy types with the rates entered for New, Renewal and Endorsement.  If a 
percentage is incorrect, the user can change the percentage in the grid. 

 

 

Figure 9: Change Percentage 

 

6. Some carriers may have multiple commission tiers for the same line of business.  Commission rates 
can be broken down further by plan.   

a. Add a new line by hitting the plus button.   

b. Select the line of business in the Policy Type field using the drop down box. 

c. Select a Plan from the drop down box. The plan list comes from the Companies tab. 

d. Enter the commission percentage for that plan. 
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Producer Splits 

This area contains the producer commission split with each carrier.  Again, using the Auto Fill button is 
recommended.  This should not be done unless the producer commissions have been entered on the 
Producers tab.   

1. Click the Auto Fill button. 

 

 

Figure 10: Auto Fill Producers 

 

2. This will list out all of the producers.  Click on Select All and click OK. 

3. This will pre-fill the commission splits for all producers using the percentage entered on the Producers 
tab.  If a percentage needs to be modified, change it in the grid. 

 

 

Figure 11: Change Producer Commissions 
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Cities 

This tab contains a list of all cities, states, zip codes and counties in the United States.  Put a check mark 
in the states that the agency writes business.  When entering a client, the city, state and zip will be a drop 
down box that pulls from this list.  If a city needs to be added to the list, click the plus button and type the 
new city, state, zip and county.  If a city is being removed, highlight the record and hit Control+Delete.  
Agencies have a choice of having the list appear in either initial caps or all upper case.  The default is 
initial caps.  If the agency would prefer all upper case, then click on the Upper Case button. 

 

 

Figure 12: Cities Tab 

Policy Types 

This tab contains a list of all the policy types in FSC Manager.  Some policy types do not use an ACORD 
application.  These are indicated with the abbreviation MISC in the Application column.  Agencies may 
not add new policy types to the system.  New miscellaneous policy types can be added by contacting 
Customer Service. 

System Defaults 
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Most of the System Defaults will be determined during the installation process.  These settings can be 
altered as needed.  Several of these defaults are explained in the chapter covering the following topics: 
Tranlogs, Memos and Imaging. 

 

 

Figure 13: System Defaults 

 

A Default Sub-Agency should be selected if the agency has only one location (sub-agency).  If the agency 
has multiple locations, leave this field blank.  Each time a client is added, the system will prompt the user 
to assign it to the appropriate location. 

Auto ID Card allows the agency to select the ACORD 50, ACORD 50 Watermark or a Custom ID.  The 
ACORD ID cards can be emailed out of the system.  Selecting an ACORD ID will print ID cards that are 
applicable to the agency’s state. The custom ID card can not be emailed.  The custom ID card is not state 
specific.  It prints three ID cards to a piece of paper. 

Firebird Settings are settings for the Firebird database.  These settings should only be altered with the 
help of Technical Support when necessary. 

Signature Setup 

FSC Manager supports inserting a scanned signature into an ACORD application or form so that a user 
can easily email ACORD documents.  To setup scanned signatures follow the steps below. 

1. Sign a piece of paper and scan the document 
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a. When signing the paper, use a dark pen, sign in a straight line and keep the letters similar in 
scale to each other. 

b. Scan the document and save as a monochrome bmp.  If the scanner does not allow for this, 
scan and save as a jpg.  Then open the jpg in Paint and save as a monochrome bmp. 

2. Load the signature into FSC Manager. (Must be a level 1 user to do the remaining steps) 

a. Click on the System button on the Banner. 

b. Go to the System Defaults tab. 

c. Click the Signatures button. 

d. Click the menu item Signature -> Insert from File. 

e. Browse to find the bmp file created and saved in step 1 above and open it. 

f. The signature will display in FSC Manager.  Use the mouse to click and drag a box around 
the signature.  Include the entire signature, but as little white space as possible around the 
signature. 

 

Figure 14: Signature Selection 

 

g. Click the Save Selection button. 

h. Assign the Signature a name and click OK. 

i. Click OK to save signature. 

3. Assign the signature to a user(s).  This enables the agency to control a user’s access to signatures in 
the system. 

a. In the System Defaults, click on Signatures button. 
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b. Click the menu item Signatures -> Authorization. 

c. On the left, highlight the user. 

d. On the right, select a signature name from the drop down. 

e. Click the + button to add additional signatures to the same user. 

f. Click OK to save assigned signatures. 

g. Click OK to save settings. 

 

Figure 15: Signature Authorization 

Notifications 

FSC Manager will deliver information to the user through Notifications that will appear on the Main Screen 
below the Followups.  There are four types of Notifications: Scheduled Download, Download Premium 
Change, Database Maintenance Tasks and Up Front Imaging. 

NOTE: Any user may receive a Notification; however, security rules do apply.  Example: If a user 
is not authorized to access the Premium Change report, they may still receive a Download 
Premium Change Notification, but will not be able to open the Notification. 

 

Notification Setup 

1. Click on the System button on the Banner 

2. Go to the System Defaults tab 
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3. Click the Notifications button 

4. Highlight a Notification at the top 

5. Click the Define Rules button and select the Notification criteria (only the Downoad Premium 
Change requires rules) 

6. Select user(s) who will receive the Notification 

7. Click OK to save changes and exit 

 

Figure 16: Notification Viewer 

 

Notification Details 

Scheduled Download 

Agency must contact FSC Customer Service to have the Scheduled Download task set up in Windows. 

Creates a notification when any of the following happens: 

Transactions have been put into suspense during the scheduled task 

The user processing the suspended transactions pauses the download 

Download has an error when running as a scheduled task 

The download processing completes 

The user may launch the download process from the notification or view the Download 
Transaction and Download Error/Information reports. 

 

Download Premium Change 

Creates a Notification when the download has been completed.  This Notification will deliver the same 
information as the Premium Change report.  The user may click on the client name to open the Client 
screen or the policy number to open the policy. 
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Figure 17: Premium Change Notification 

 

Database Maintenance Tasks 

Notification will take place the first time a user opens the system for the day  if any of the following are 
true: 

It has been more than one day since the Backup Database task has been run 

It has been more than seven days since the Backup and Restore Database task has been run 

It has been more than seven days since the Pack Tables task has been run 

It has been more than one  day since the Reorganize IMSdata task has been run 

 

The Notification will contain a link for the user to open the Tasks area 

Local Defaults 

This tab stores information about each user’s local setup for FSC Manager.  This section will need to be 
done at each user’s computer.  The user should log into FSC Manager using their User Name. 
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Figure 17: Local Defaults 

Auto Fill Clients 

Users may choose to have all new clients default to Personal or Commercial.  If Neither is selected, the 
user will be prompted to choose Personal or Commercial each time a new client is added. 

Memo Options 

Auto Followup from Memo – when this option is checked, the system assumes that after a memo is 
closed, the user would like a Follow Up and pops the Follow Up screen. 

Fill TO field on memo with client – when this option is checked, a memo will pre-fill the TO field of a memo 
with the client name and address. 

Append Email Signature to New Memos - this option will allow the user to have their email signature pull 
into all new memos. 

Email Options 

FSC Manager works with a user’s Outlook or Outlook Express email program.  If not using the either of 
these programs, the user will have to provide SMTP server information during the email setup. 

1. Click the Setup Email button. 

2. Choose MAPI (if using Outlook or Outlook Express). 

3. Enter SMTP server information if using an email program other than Outlook or Outlook Express.  
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Figure 18: Email Setup Click Next. 

4. Click OK. 

Outlook Integration  

 

FSC Manager will integrate directly with Outlook versions 2003, 2007 and 2010.  The new email features 
will not function with Outlook Express or Windows Live Mail. If you are currently using an internet-based 
email program, talk with your hardware vendor to determine if it can be accessed via Outlook.  
  
NOTE: If a user is operating FSC Manager in a Terminal Server or Citrix environment (e.g. ASP), 
Outlook must run from the Terminal Server/Citrix rather than locally on your desktop.  Please 
work with your ASP or hardware vendor to implement Outlook in Terminal Server/Citrix before 
turning on the Outlook integration. 
 
Recommended Setting:  Set the message format in Outlook to HTML.  (Tools->Options->Mail Format tab) 
 

Turning on Outlook Email Integration (Must be completed once by each user) 

1. Go to the System button on the Banner 

2. Go to the Local Defaults tab 

3. Click on the Setup Email button  

4. In the MAPI Type field, select Extended MAPI and click OK 

 

 

Sending Emails 
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When a user clicks the Email button in FSC Manager , the Outlook New Message screen will open.  
The user’s default signature in Outlook will automatically populate in the email body. 
 

 

Figure 19: FSC Manager Add-In Buttons 

 

A custom tool bar has been added to Outlook whenever an email is initiated from FSC Manager.  
Depending on the version of Outlook, the custom toolbar may appear in different places.  In Outlook 2007 
or 2010, the custom toolbar will appear on the Add-Ins tab (see above).  In Outlook 2003, the toolbar will 
appear below the subject field of the email (see below).  The custom toolbar integrates information from 
FSC Manager.   

 

 

Figure 20: FSC Manager Add-In Buttons 
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Custom Add-In Buttons 

To, Cc, or Bcc buttons - opens the Address Book Viewer in FSC Manager.   

 

Figure 21: Address Book Viewer 

 

Category button - select a Tranlog category for the email.   
 
Template button - select a Memo Template that will merge information from the client and policy into the 
body of the email.   The recommended workflow for emailing a memo is to open the Email first and select 
a Template from the email screen.  Warning:  If the user opens the Memo area and sends the email 
from the memo, two tranlogs will be created.  When a memo template is inserted, it will remove the 
default signature.  The email template may contain a signature or it can be inserted from Outlook. 
  
FollowUp button – allows user to create a Follow-Up from the email.  If the user has the System or Local 
Default turned called “Populate FollowUp with Memo/Email,” the FollowUp will be created automatically 
when the email is sent and the email text will appear in the Follow Up. 
 
Attachments button - opens the Select Email Attachments screen. 
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Figure 22: Select Attachments 

Attachments may also be added by dragging and dropping to the email screen or by clicking on the 
Attach File button in Outlook and browsing in Windows explorer to find an attachment. 

Emails sent from anywhere in FSC Manager will automatically record to the Tranlog.  Emails sent from 
Outlook outside of FSC Manager will not record to the Tranlog. 

 

 

Recording Incoming Emails to Tranlog 

Drag an email from your Outlook Inbox; drop it on the Client or Imaging screen.  The Tranlog Appender 
will open.  The email header and body will record into the Tranlog.  In the top area, the user may add 
additional comments that will append to the top of the saved Tranlog.  If the email is dropped on a specific 
policy on the Policies tab, the Tranlog will include the policy number.  Users may also select the policy 
number after the Tranlog Appender opens. 
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Figure 23: Tranlog Appender 

 

If images are attached to the email, the user will be prompted with the question, “Do you want to add the 
email attachments to imaging?”  Answering "yes" will start the normal attaching process directly from the 
Client screen instead of the Imaging screen.  This is more convenient and efficient way to add the 
attachments from an email.  

 

Email Using Simple MAPI/SMTP 

For users not implementing the new Outlook integration, a plain text email signature can be set up to 
default into the current email screen.  To set up the default signature: 

1. Go to System button on the Banner 
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2. Go to the Local Defaults tab 

3. Click on the Setup Email button  

4. Click the Signature button 

5. Enter your signature information.  This is in plain text which means it does not support font styles, 
size, or formatting. 

6. Click OK to save the signature 

7. Click OK to exit the setup 

Users may also determine if they want the email signature to default when emailing a memo.  If the user 
would like this feature, in the Local Defaults, put a check mark in “Append Email Signature to New 
Memos.” 

Miscellaneous 

Refresh Main Screen Every 5 Minutes – This default controls the refreshing of the Follow Up grid on the 
Main Screen.  This area automatically updates at 5 minute intervals.  Users can increase or decrease the 
interval. 

Follow-Up Reminder on Client Screen ____ days – the Follow Up tab on the Client screen will turn yellow 
if a Follow Up is due with in the number of days specified.  Leaving it at zero will make the tab turn yellow 
only if a Follow Up is past due. 

Accounting Path and EXE File – this path should only be set on the user that does the accounting 
integration (optional).  The path should point to the same exe that the accounting shortcut references. 

Auto Show Quicknotes (recommended) – this option should be checked so that all Quick Notes which 
are similar to post-it notes on a Client screen automatically open when the client is opened. 

Locater Manual Refresh – this option should only be turned on if the agency has large amounts of data 
and the Client locater is slow.  Normally the locater will refresh each time the button is clicked.  When this 
option is turned on, the locater will refresh the first time a user clicks on it each day.  Throughout the rest 
of the day, the user would have to click the Refresh button to refresh the data. 

Locater Search on Enter – this option should only be turned on if the agency has large amounts of data 
and the Client locater is slow.  Normally, the locater searches after each character.  When this option is 
turned on, the locater will not search until the user hits enter. 

Roll Dates on Copy App – this features works with the Copy App button on the Client screen.  If this 
option is enabled, the dates will roll forward one policy period.  This is useful if a user generally copies an 
application for requoting purposes. 

Ask if Word is Closed – this option needs to be enabled if Microsoft Word locks up when a Single Letter 
or Marketing Letter is closed.  This option will prevent the lockup.  It is not needed on all computers. 

Print applications Bold – this option will make the application data print bold. 

Import\Export Setup 

This tab contains the setup for importing and exporting data to the various raters.  Currently, FSC 
Manager can integrate with FSC Rater, FSC Rater RT, MI Rater and Quomation Power Quote.   
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For information on setting this up, please refer to the chapter on Rater Integration.  Usually the setup will 
be completed by the trainer or a Customer Service technician. 

Security Settings 

If the agency would like to set a tab in the System area to be viewed by only a certain level user this can 
be accomplished by the following. 

1. With the System area open be on the tab to setup and press Alt + F7. 

 

Figure 24: Security Setup 

2. Select the user level to be modified. 

3. Click OK to open Security HotKeys box. 
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           Figure 25: Security Hotkeys 

4. Select either Read Only (user level will be able to view but not change) or Hidden (this tab will not 
open for the user level you have selected). 

5. Repeat these steps for each user level to be modified. 

Security for Life, Health, and Financial Products 
The purpose of Health Insurance Portability and Accountability Act of 1996 (HIPAA) was to address the 
security and privacy of health related data.  With this in mind, FSC has developed a feature to limit private 
information to licensed individuals.  The system administrator will determine which policy types related to 
life, health and securities (financial products) can be secured.  The administrator will also determine 
which users are licensed in each of these areas and therefore granted full access to all information 
regarding these products.  The security will extend to the Applications, Tranlogs, Follow-ups, Memos, and 
Images.  Non-licensed personnel cannot access secure information. 

These new security features are not required; however, this feature allows agencies dealing with life, 
health or securities to restrict information to licensed users. 

Setup 

1. Assign the Security Administrator   

a. Go to the System button on the Banner 

b. On the System Defaults tab, select a user from the drop down list for the Security 
Administrator field 
  
NOTE: Only the Security Administrator may change this field once it has been set. 
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Figure 26: Security Administrator 

2. Categorize the policy types as life, health or securities for privacy protection.   

a. Go to the System button on the Banner 

b. Go to the Policy Types tab 

c. Highlight a policy type and click the Edit button 

 

Figure 27: Policy Types 
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d. Select a Security Setting and click OK 

e. Repeat this for each policy type to protect 

 

Figure 28: Categorize Policy Types 

 

3. Determine each user’s licensing 

a. Exit FSC Manager 

b. At the Login, go to Admin Utilities 

 

Figure 29: Login 

 

c. Highlight a user and click the Edit User button 
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Figure 30: Assign User Licensing 

d. Put a check mark in the areas that the user is licensed.  A user may be licensed for 
multiple areas. 

e. Repeat this step for each user that is licensed 

 

Security for Licensed Users 

As a licensed user, all Tranlogs, Follow-ups, Memos and Images related to a secured policy type will be 

marked as secure by default with this icon   .   When this icon is red , the item is secure.  When the 

icon is gray , the item is not secure. 

 

Tranlogs, Follow-ups, Memos and Images related to a secured policy type created in the following ways 
will be secured by default: 

» Create the Tranlog, Follow-up or Memo directly from the policy screen 

» On the Client screen, highlight the policy before creating the Tranlog, Follow-up or Memo 

» On a Memo or Follow-up initiated from the Client screen or Main screen, use the Policy Select 
button 

» Attach the image from the policy screen 

» Attach the image from the Main screen at an App level 

 

In addition to the above defaults, at any time, a licensed user may manually secure a Tranlog, Follow-up, 
Memo or Image by clicking the Secure icon which changes to red.  If the user is licensed in multiple 
products, they will be prompted to select a product.  Licensed users may also remove security from an 
item by clicking the Secure icon which changes to gray.   

 

 

 

 

 



 
FSC Manager 

System Setup 

 

 

Page 28 

© Vertafore | 26650 W. Mondovi Street | Eleva, WI | 54738 

 

 

 

Figure 31: Securing a Tranlog, Memo, Follow-up or Image 

 

In Imaging, licensed individuals will have a new user option.  Open Imaging and go to Options->Imaging 
Options->User Options tab.  The new option is called “Always prompt for security when attaching an 
image”.  Because many users attach all images directly from the Client screen, meaning they are not 
linked to a policy, this option will prompt the user to assign life, health or securities settings to every 
image they attach.  This is generally recommended if the user spends the majority of his/her time doing 
life, health or securities related work.  The user can also assign security manually after attaching each 
image. 

Secure Follow-ups may only be directed to users that are licensed in the appropriate product. 

The Tranlog created by emailing from the Client screen is not secure because the email is not linked to a 
policy.  The Tranlog created by the email may be made secure manually after the email is sent by going 
to the Tranlog and clicking on the Secure icon. 

 

Security for Non-Licensed Users 

Non-licensed users cannot create secure Applications, Tranlogs, Follow-ups, Memos and Images. 

Once Policies have been secured, non-licensed users cannot: 

» Open, print or copy secured policies  

» Access secure policies through the Apps button on the Banner   

» Create additional secure policies 
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Figure 32: Secure Policies 

Once Tranlogs have been secured, non-licensed users cannot: 

» Open or print a secure Tranlog 

» View content of secure Tranlogs on the Tranlog Reports 

 

Figure 33: Secure Tranlogs 

Once Follow-ups have been secured, non-licensed users cannot: 

» Open or print a secure Follow-up 

» View content of secure Follow-ups on the Follow-up Report 
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Figure 34: Secure Follow-ups 

 

Once Images have been secured, non-licensed users cannot: 

» View, print or email secure Images 

» Delete, un-attach or re-categorize secure Images 

Note: Secure images are encrypted on the hard drive. 

 

Figure 35: Secure Images 
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Running Updates 

FSC will release anywhere from 1-3 updates to the Manager per year.  The user will be notified that an 
update is available via email.  Once the user has received the email they will need to update the system 
to insure they are using the most current version of FSC Manager. 

1. Click Help on the FSC Manager banner. 

 

 

Figure 36: FSC Manager Update 

2. Click Update System to start the update. 

3. When the update is complete the user will be asked to confirm the update. 

 

 

Figure 37: Confirm Update of Files 

 

4. The user must click Yes to update files and continue into FSC Manager. 
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Address Book 
 

FSC Manager contains an Address Book that integrates with Email, Letters and Marketing.  Users can 
add frequently used contacts to the Address Book, to eliminate having to type in the data each time it is 
used. 

 

 

Figure 38: Address Book 

To add a new Address Book entry click the blue plus button at the top of the screen.  To add a new 
contact for an existing entry use the plus and minus buttons in the middle left of the screen. 
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Obtaining Support 
 
 
If you have any questions about this training, please contact FSC Customer Support.  Thank you and 
enjoy using FSC Manager! 
 
West Coast Customer Support: 800-433-2550 
Midwest Customer Support: 800-401-2895 
Email: fscmanagersupport@fscsolutions.com 
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